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Adobe Premiere 6.5 Tutorial
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Adobe Premiere 6.5 Tutorial
Note: Before we begin, we need to set the project settings. Double-click the Premiere 6.5
icon to launch the application. You should get a Load Project Settings window.  We want
ot take advantage of Premiere 6.5’s new Real-time Preview capability, so under the DV –
NTSC Real-time Preview folder (click the little gray triangle if necessary to reveal the
folder contents), select Standard 48kHz for our project settings.  This will be the default
working mode for our project. Then click the OK button to finish launching Premiere 6.5.

1. Go under the File menu and select Import>Folder. Navigate to the Adobe Premiere
6.5 application folder and select Sample Folder. Click the Choose button and the
sample folder and its contents will be imported into Bin 1 in your Project window.

2. Double click the Sample Folder icon under Bin 1 in the Project window to reveal the
contents of the folder. You should see the following files: Boys.mov, Cyclers.mov,
Fastslow.mov, Finale.mov, Music.aif, Veloman.eps, and the movie we are trying to
recreate, Zfinal.mov.

3. Before we start, let’s take a look at Zfinal.mov (the last one in the list in the Project
Window). Double-click its icon. It will open to a new window that will allow you to
play the movie. Go ahead and watch the movie to get an idea what we’re shooting for.
You may close this window now. You can open it again anytime you need to refer to
it.

4. We need to set a good view for our movie in the Timeline window. Since the movie
will be about 30 seconds long, let’s set the Time Zoom Level to 1 second if it isn’t
already, so we’ll be able to see most of the movie without scrolling. To do this, click
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on the pull-down menu in the lower left corner of the Timeline window and select 1
Second. You’ll see the numbers at the top of the Timeline window will change to 1
second intervals. This is the Time Zoom Level  and you can adjust it to suit your
needs as you work.

5. Now let’s add the soundtrack. Click on Music.aif in the Project window, and drag it
down into the Audio 1 track. The track will turn black, signifying that you may drop
the item on that track. Click on the triangle next to Audio 1 to see the sound track’s
sound wave. We’ll use this to help synchronize the sound and the video.

6. If you look at the finished movie, you’ll see that it starts with a clip from boys.mov.
Double click on the boys.mov to open it in its own window. We see that this clip is
much longer than the one we’re going to use for the final movie, so let’s edit its
length before dragging it to the Timeline. Move the blue downward-pointing arrow
(the playhead) to about 00;00;04.03. Now click on the right-facing bracket at the
bottom of the clip window. It looks like this:  } (it’s circled in the image below). This
sets an outpoint for the video. You’ll see that the play area turns yellow, indicating
that this is the cropped area of the clip. You can likewise set an inpoint for the clip by
clicking on the left-facing bracket, somewhere along the play area, however, we don’t
need to do that with this clip. Now click on the video in the clip window and drag it to
the Video 2 track. Like the audio clip we dragged earlier, the track will turn black,
allowing us to drop it there.
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7. Our video is still a bit short, so we’ll need to lengthen its duration a bit. We’ll use the

Rate Stretch Tool  for this.   If you don’t see it in your tool bar, click
and hold  down in the area marked above in the red circle. You’ll see other choices
there as well. Any time a tool has a right-facing triangle, it means that there are other
choices in addition to what is actually showing. We want the video to be about
00:00:05:18 in length. To accurately see the clip’s length in the timeline, go under the
Window menu and select Show Info. The Info window appears. The Info window is
going to be your best friend in Premiere. Now select the Rate Stretch Tool icon in the
tools menu on the left side of the timeline, and position it over the right edge of the
Boys.mov in the Timeline window. You’ll see the tools icon appear there. Now,
watching the Info window, drag the right side of boys.mov untill the cursor reaches
00:00:05:18. The movie is now a bit longer, and will play a bit slower than before.
Looking at the Audio 1 track, the boys.mov clip should end just as the music changes.
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8. We also see in our finished movie that the video fades up from black. To do this,
click on the little triangle next to Video 2. It will reveal a couple of control icons.
Click on the red square with the diagonal line going through it. This will make a red
line (the Opacity Rubber Band) appear under the clip. This line controls the opacity
of the video and is not available on the Video 1A and Video 1B tracks (that’s why we
put our clip on the Video 2 track). Right now it’s set to 100%. Click on your arrow
tool, then click on the red line at about 1 1/2 seconds into the clip (the third tick
mark). This will make a keyframe appear on the red line. Now drag the point to the
left of your new keyframe down to the bottom  so that the red line will angle up to
your new keyframe.  This sets the opacity to 0% (black) at the beginning of the clip,
then it will gradually change to 100% opacity at 1 1/2 seconds into the clip, making
the clip appear to fade in. That wasn’t too hard, was it?

9. Our next clip will be a section from cyclers.mov, so double click on it to open it in a
Clip window. Place an outpoint (right bracket) at 00:00:02:21, then drag the clip into
the Timeline into the Video 1A track. Move it so it is just to the right of the clip you
have in the Video 2 track. It should snap into place there.

10. Close the Clip window and then open a new one by double clicking on fastslow.mov.
Set an inpoint at 00:00:00:00 and an outpoint at 00:00:04:17. Drag this video clip to
the Timeline into the Video 1B track. This time, since we need to add a transition,
make it overlap the clip in Video 1A by about a second. Looking at your Info
window, the left side of the clip you’re adding should start at around 00:00:07:00 and
end where the audio in the Audio 1 track wave form changes.
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11. Now we’ll add the transition. Under the Window menu, select Show Transitions. In
the Transitions window, click on the gray triangle next to the Dissolve folder, then
double click on Cross Dissolve. A window will open showing a sample of the
dissolve. You can adjust how much of each movie clip to start and end the dissolve
with, but we’re goint to leave it starting at 0% and ending at 100%. Close the Cross
Dissolve setting window. Now drag the Cross Dissolve icon from the Transitions
window to the Transition track between the Video 1A and 1B tracks. It should go
into the area of overlap between the 2 clips in those tracks. It will automatically fill
up the space for the length of the overlap of the 2 clips.

12. At this point, let’s stop and see what we’ve got so far. Since transitions and fades
need to be rendered before we can see the results of what we’ve done, go up under the
Timeline menu and select Render Work Area (the second choice). Premiere will
then bring up a status window showing how many frames need rendered and what the
status of the rendering is. Once that’s through, the monitor window should begin
playing the movie. You can stop it after the video stops playing. Otherwise it will
keep playing the soundtrack.

13. The next portion of the video is the slow-motion bike. Open fastslow.mov in a clip
window. The inpoint will be at about 00:00:04:18 and the outpoint will be at the end
of the clip. Drag this clip down to the Video 2 track at about 00:00:11:18 on the
timeline. Anytime you want to add transparency or motion, the clip needs to be in
Video 2 or higher. We’ll be adding a fade to this clip, which is a transparency.
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14. If you can’t see the sound wave in the Audio 1 track, click on the triangle next to
Audio 1 and then click the first icon below it (the one that looks like a sound wave).
You’ll see the sound wave in the audio track. Look at where you started this last
video clip in Video 2. Does it line up with the start of the subdued part of the audio?
This is a great way to get the audio and video in synch. Also, you’ll notice that the
clip is a bit too short to cover the length of the subdued bit of the sound track. Click
on your Rate Stretch Tool and drag the right side of the clip till it comes to where
the music suddenly changes tempo. Again, this will slow down the video clip, but
that’s the effect we’re going for here.

15. There is a fade to black at this point in the final movie, so in the Video 2 track, make
sure you can see the opacity rubber band. Click on a point at 00:00:14.14, then drag
the keyframe at the end of the click down to the bottom so that the red line descends
from that point to 0% opacity, like you did for the first clip.
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16. The next clip will come from finale.mov, but we won’t need to edit this movie at all,
so just drag it down to the Video 1B track. We need to add a blur at the end of the
clip, so under the Window menu, select Show Video Effects. Under the Blur folder
in the Video Effects window select Gaussian Blur, and drag it onto the clip you just
put in Video 1B. The clip will turn dark blue, signifying that you are dropping the
filter on the clip. Note that video and audio filters are applied directly on the clips,
while transitions are applied between clips. A green line will appear at the top of the
clip to signify that a filter has been applied. Click the triangle next to Video 1B to
reveal the rubber band for the filter. You’ll see a line with 2 white boxes in the track.

17. We need to set some keyframes on the Gaussian Blur so that it won’t affect the whole
clip, just the end of the clip. Drag the left white square in the finale.mov clip in
Video 1B to the right until you get to about 00:00:24:14 on the timeline (watch your
Info window). Now move the playhead (the blue triangle in the timeline) to about
00:00:26:00 and click on the white box between the left and right arrows (under
Video 1B) to add another keyframe. A white diamond will appear there. Also note
that the 2 white squares have changed to diamonds as well.
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Click on the diamond that you just made at 00:00:26:0. In your Effect Controls
window (Windows>Show Video Effects), drag the Bluriness control for the
Gaussian Blur to 8.2. Click on the first diamond (at 00:00:24:14) and make sure its
Bluriness is set to 0.0. This will make the blur gradually take effect from 00:0024:14
through 00:00:26:00.

18. The clip still isn’t long enough to make it to the end of the sound track, so we need to
lengthen it. Rather than toy with the clip’s speed too much we’re going to stretch the
last few frames. Place your cursor at about 00:00:30:00. Now with your Razor tool,

  cut the clip where you have the cursor. It will become 2 separate clips at that
point. Select your Rate Stretch tool and stretch out the last clip till it reaches the end
of the audio. We’re almost done.

19. Next we add the spinning logo. Drag Veloman.eps down to the Video 2 track starting
at the point where your first video effect keyframe is on the last clip (around
00:00:24:14). With your arrow tool selected, drag the right side of the clip till it goes
to the end of the movie. In the Effect Controls window, click on the box next to
Transparency. The Transparency Settings window should appear. Next to Key
Type, select White Alpha Matte in the pull-down menu. The white alpha matte
makes the white background turn transparent. You should see the Veloman logo
appear over the bikers in the background. If you don’t see the logo over the video,
make sure the page curl icon is selected (circled in red). Click OK.
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20. Now, with the Veloman.eps graphic in Video 2 still selected, click the box next to
Motion in the Effect Controls window. The Motion Settings window appears. In the
window at the right, click on the white square to the left of Visible Area to select it if
it isn’t already. Set the Zoom to 15% and click your Return key to set the value. The
logo gets smaller. Now move the logo next to the edge of “Visible Area”.

         

Click on the white box to the right of Visible Area. Set its Zoom to 1%, set the Rotation
to 720, and then drag it inside the right edge of the Visible Area and up a bit.
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21. Now click on the middle of the black line in the Visible Area. This will add another
keyframe. Move this keyframe down a bit below the middle in the Visible Area
window. Set the Zoom to 100%. The logo should now increase in size till it gets to
the middle, then decrease in size as it goes to the right. We want it to stop in the
middle for a while, so set Delay (below Zoom) to 15%. Click the OK button.

          

22. Now Render Work Area again (under the Timeline menu) and watch your finished
video.
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